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Introduction
The Zebra Fonts and Graphics Downloader is a software package dedicated to preparing and 
downloading TrueType fonts to the memory installed in printers. Fonts that are downloaded to 
the memory card are treated as internal printer objects. This enables much faster printing 
because there is no need to transfer text to the printer at print time.

Zebra Fonts and Graphics Downloader can:

• Add, edit, and view data prepared for download on memory.

• Check the available memory space before downloading.

• Share the information about the contents of the memory card with the ZebraDesigner Pro 
labeling software.

Print the downloaded data from the memory.
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User Interface

Main Window

Figure 1 • Fonts and Graphics Downloader window

Menus

All actions can be done by using pull-down menus.

Font and Graphic List Box

All currently selected fonts and graphics are shown in these two list boxes. You can access pop 
up menu by pressing right mouse button. Popup menu contains the same commands as 
corresponding main menu (Fonts or Graphics).

If there is an icon displayed in front of a font name, that font is already downloaded to the 
memory card.
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User Interface
Memory Card Slot Selection

Here you can select to which memory location in the printer you want to store fonts and 
pictures.

Note • Different printers have different memory card slots.

Preview Area

In the preview area you can review the selected font or graphic files. On the left side you can 
see basic dimensions and memory size of selected objects (fonts or graphics).

Status Line

In the status line, you can see the currently selected printer.

The fields contain the information about the size of selected and downloaded objects, and the 
memory card size.
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Customizing the Software
To change the preferences of the application, do the following:

1. From the Tools menu, select Options.
The Options dialog box opens.

2. You can change the options regarding the default folders and test string.

To customize the menus and toolbars, do the following:

3. From the Tools menu, select Customize.
The Customize dialog box opens.

4. Make modifications to the settings.

5. Click the OK button.

You can also change the positions of the toolbars onscreen. Drag them to the new position.
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Creating Memory Card Configuration File
The memory card configuration files store the information about the objects currently on the 
memory card. Each configuration file is linked to a thermal printer. When you are designing a 
label in ZebraDesigner Pro or ZebraDesigner, the memory card configuration file provides the 
information about downloaded objects. ZebraDesigner Pro and ZebraDesigner then knows 
which objects can be recalled from the memory card.

To create new memory card configuration file, do the following:

1. From the Card menu, select Printer Selection.
The Select Printer dialog box opens.

Note • You can also click the  button in the toolbox.

2. Select the printer from the list. Make sure to select the ZebraDesigner printer driver.

3. From the list, select the Memory card slot type.

Note • The available card slot types change accordingly to the selected printer.

4. From the Card menu, select New.
The New card dialog box opens.

Note • You can also click the  button in the toolbox.

5. Type the name of the new memory card configuration file and click the Save button.
The Card Setup dialog box opens.

6. Enter the description of the memory card (optional) and select the proper card size.

7. Click the OK button.

You have created an empty memory card configuration file.

You can start selecting the fonts to be downloaded to the memory card.
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Adding Objects to the Memory Card

Adding Fonts to the Memory Card

To add fonts to the memory card, do the following:

1. Create your memory card configuration file.

2. From the Fonts menu, select Add.
The Download Mode dialog box opens.

3. Select the font download mode.

4. If you have selected Download All Characters, then select the font you want to 
download.

5. If you choose Download Selected Characters: 
a. Select the font you want to use.
b. Click OK.
c. Click the Characters button to select specific characters.
d. Select the characters you want to download.
e. Click OK twice.

6. Repeat step 2 through 5 to select additional fonts.

7. Make sure the printer is connected to the computer.

8. When the Confirm dialog box appears, click Yes to download the fonts to the printer.

9. Review the License Agreement.

10. When the fonts are downloaded to the printer and stored to the memory card, they can 
then be used on label designs.
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Adding Pictures to the Memory Card

To add pictures to the memory card, do the following:

1. Create you memory card configuration file.

2. Select the command Add in the Pictures menu.
The Open dialog box opens.

3. Select the picture from the hard drive you want to download.
You can preview the selected picture in the preview area.

4. Repeat the steps from step 2 and 3 to select additional pictures.

5. Make sure the printer is connected to the computer.

6. Select the command Download All from the Card menu.
The pictures are downloaded to the printer and stored to the memory card. You can use 
them on your label.
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Downloading Objects to the Memory Card
The defined objects can be downloaded one at a time, or all at the same time. It depends on the 
selected printer.

To download all objects to the memory card, do the following:

1. From the Card menu, select Open.

Note • You can also click the  button in the toolbox.

2. Select the memory card file that contains the objects you want to download to the memory 
card and click on the Open button.

3. Make sure the printer is connected to the computer.

4. From the Card menu, select Download All.

To selectively download objects to the memory card, do the following:

1. From the Card menu, select Open.

Note • You can also click the  button in the toolbox.

2. Select the memory card file that contains the objects you want to download to the memory 
card and click on the Open button.

3. Make sure the printer is connected to the computer.

4. Select the object you want to download to the memory card.

5. If you picked a font, select Download from the Fonts menu.
The object is downloaded to the memory card.

6. If you picked a picture, select Download from the Picture menu.
The object is downloaded to the memory card.

7. Repeat step 1 through step 6 for the other objects you want to download.
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Removing Objects from the Memory Card
Once the objects have been downloaded to the memory card, you cannot selectively remove 
them on all printers. 

If the printer does not support selective object removal, the only method is to format the 
memory card and download again, all the objects that you still need.

Do the following:

1. From the Card menu, select Open.

Note • You can also click the  button in the toolbox.

2. Select the memory card file that contains the objects you want to remove from the 
memory card and click on the Open button.

3. Make sure the printer is connected to the computer.

4. From the Card menu, select Format.
The contents of the memory card will be erased.

Note • You can also click the  button in the toolbox.

If the printer does support the selected object removal, do the following:

1. Select the Open command in the Card menu.

Note • You can also click the  button in the toolbox.

2. Select the memory card file that contains the objects you want to remove from the 
memory card and click the Open button.

3. Select the object you want to remove from the memory card.

4. If you picked a font, select Delete from the Fonts menu.
The object is removed from the list.

5. If you picked a picture, select Delete from the Picture menu.
The object is removed from the list.

6. Repeat step 1 through step 6 for the other objects you want to delete.
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Using Toolbox
Use the toolbox to have quick access to shortcuts for the commands

If you do not see the toolbox, from the View menu, select Toolbox. The toolbox will display 
under the menus.

Note • You can change the position of the toolbox and dock to any other position.

These are the buttons in the toolbox:

Create new memory card.

Open existing memory card.

Select printer where you want to download objects.

Display the information about the memory card.

Format the memory card in the selected memory slot.

Reload the contents of the memory card. Send all 
objects to the memory card.
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Card Menu

New

Creates a new memory card file.

The memory card file you create will be connected to the currently selected memory slot. For 
every memory slot in the printer, a different memory card file can exist.

Note • Make sure that you have the correct printer and memory slot defined before you select 
this command. If the printer doesn’t support memory cards, this command will be disabled.

Open

Opens the existing memory card file and connects it to the currently active memory slot.

Save As

Saves current memory card file in the new file name.

Note • This command is used only to make a copy of an existing memory card file. When you 
create the memory file, all the changes that you make are automatically saved. 

Close

Closes the current memory card file.
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Memory Card Information

In this dialog, change the settings of the memory card in the currently selected memory slot.

Figure 2 • MemMaster Card Setup dialog box

Printer information: In this section, you can find more information about the currently 
selected printer. You can see the major properties of the printer driver.

Memory Card: In this section, you find out more information about the currently selected 
memory slot.

• Description: Enter the description of the memory card.

• Card size: Select the size of your memory card (in kilobytes).
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Printer Selection

This command displays a printer selection dialog box where you can select your printer. The 
objects will be downloaded to this printer.

Figure 3 • Printer Selection dialog box

Format
Important • Formatting erases all the data on the memory card.

This command will format the memory card so that it is prepared to download data to the 
memory card. 

Reload memory card

When this command is executed, the program formats the memory card, and then reloads all 
already downloaded data to the selected memory card.

Note • You can use this option to make duplicates of the memory cards.

Download All

This command downloads all the fonts and pictures in the current configuration file to the 
memory card.

Status Print

Prints a test label with basic information about the downloaded objects.
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Exit

This command will close the program.

Note • When you will exit the program, the Windows operating system does not know about 
the changes you have made to the memory card. Before using the downloaded graphics or 
fonts, you will have to notify the appropriate printer driver about the changes. If this is not 
done, you will not be able to select downloaded pictures or graphics. Once this is done, the 
printer driver automatically updates the changes on the memory card. 

You should also be aware that the labeling application saves printer settings in each .LBL file. 
The printer settings have to be updated in all .LBL files, connected to the selected printer, if 
you want to use graphics and fonts on the memory card. For more information, refer to the 
documentation of labeling application and printer drivers.

Update Printer Settings and Return to the Server Application

Select this command to apply all changes you have made and return back to label design 
environment.

View Menu

Toolbox

Enable or disable toolbox.

Fonts

Enable or disable the font box in the main area.

Pictures

Enable or disable the pictures in the main area.
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Fonts Menu

Add

Adds Windows fonts to the configuration file.

How the fonts are downloaded depends on your printer. Some printers can accept the whole 
font file (.TTF). In this case, the font on the label can be used in any point size. For other 
printers, the selected characters are converted into pictures and downloaded as pictures into the 
printer.

Delete

This command deletes the selected font from the memory in the printer and also removes it 
from the configuration file.

Download

The highlighted fonts are downloaded to the memory card. Once the font is downloaded the  
icon appears in front of the font name.

Note • To download all selected fonts and pictures, select the command Download All from 
the Card menu.

Remove

This command deletes the selected font from the memory in the printer. The font still remains 
listed in the configuration file.

Note • The font must already be downloaded to the printer memory for this command to be 
accessible.

Edit

Edits the selected font. You can change which characters from the selected font will be 
downloaded to the memory card.

Test Print

Prints the selected font on the printer.

Note • The selected object must already be downloaded in the memory card or this option is 
not available.
10/08/2009 ZebraDesigner™ Fonts and Graphics Downloader User Guide 13859L-002



Interface Reference
Pictures Menu

28
Pictures Menu

Add

This command adds a new graphic to configuration file. The file must already exist on your 
disk and must be in one of the supported graphics formats.

Add pictures from your hard disk to the configuration file.

Delete

This command deletes the selected picture from the memory in the printer and also removes it 
from the configuration file.

Download

The highlighted pictures are downloaded to the memory card. Once the picture is downloaded 
the  icon appears in front of its name.

Note • To download all selected fonts and pictures, select the command Download All from 
the Card menu.

Remove

This command deletes the selected picture from the memory in the printer.

Note • The picture must already be downloaded to the printer memory for this command to be 
accessible.

Edit

With this command you can choose other graphic instead of selected one.

Test Print

Prints the selected picture on the printer.

Note • The selected object must already be downloaded in the memory card or this option is 
not available.
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Tools Menu

Options

Figure 4 • Properties dialog box

Folder: Define default folders for file storage. The application will first check these folders 
when looking for Pictures or memory card configuration files.

Test String: Type in the string you want to use with Test Print.
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Help Menu

Contents

The Choose Contents command opens the help file. The online help provides a comprehensive 
screen that summarizes the contents of the Help system. 

Each of the headings on the contents screen is an expanding list. When you click the 
highlighted underlined text, it displays additional help topics about the topic.

On the Web

Opens the Zebra web site (http://www.zebra.com).

About

The Choose About command displays the About Font Downloader dialog box showing 
version, serial number, and copyright information.
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Online Support
You can find the latest builds, updates, work-arounds for problems, and Frequently Asked 
Questions (FAQ) under the Support section on the Zebra Web site.
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Contact Information
Technical Support via the Internet is available 24 hours per day, 365 days per year.

Web Site: www.zebra.com
E-mail Back Technical Library: 

E-mail address: emb@zebra.com 
Subject line: Emaillist 

Self Service Knowledge Base: www.zebra.com/knowledgebase
Online Case Registration: www.zebra.com/techrequest   

Which Department 
Do You Need? The Americas Europe, Middle East, 

and Africa
Asia Pacific

and India

Regional Headquarters Zebra Technologies Corporation
475 Half Day Road, Suite 500
Lincolnshire, IL 60069 USA
T: +1 847 634 6700
Toll-free +1 866 230 9494
F: +1 847 913 8766

Zebra Technologies Europe Limited
Dukes Meadow
Millboard Road
Bourne End
Buckinghamshire, SL8 5XF
United Kingdom
T: +44 (0) 1628 556000
F: +44 (0) 1628 556001

Zebra Technologies Asia Pacific 
Pte. Ltd.
120 Robinson Road
#06-01 Parakou Building
Singapore 068913
T: + 65 6858 0722
F:  +65 6885 0838

Technical Support
For questions on the 
operation of Zebra 
equipment and software, 
please call your distributor. 
For additional assistance, 
contact us.
Please have your model and 
serial numbers available.

T: +1 877 ASK ZEBRA (275 9327)
F: +1 847 913 2578
Hardware: ts1@zebra.com 
Software: ts3@zebra.com 
Kiosk printers:
T: +1 866 322 5202
E: kiosksupport@zebra.com

T: +44 (0) 1628 556039
F: +44 (0)  1628 556003
E:  Tseurope@zebra.com 

T: +65 6858 0722
F: +65 6885 0838
E: China: tschina@zebra.com
All other areas:
tsasiapacific@zebra.com

Repair Service 
Department
For back-to-base service and 
repair.

T: +1 877 ASK ZEBRA (275 9327)
F: +1 847 821 1797
E: repair@zebra.com 
To request a repair in the U.S.,
go to www.zebra.com/repair.  

T: +44 (0) 1772 693069
F: +44 (0) 1772 693046 
New requests: ukrma@zebra.com 
Status updates:
repairupdate@zebra.com 

T: +65 6858 0722
F: +65 6885 0838
E: China: tschina@zebra.com
All other areas:
tsasiapacific@zebra.com

Technical Training 
Department
For Zebra product training 
courses.

T: +1 847 793 6868
T: +1 847 793 6864
F: +1 847 913 2578
E: ttamerica@zebra.com 

T: +44 (0) 1628 556000
F: +44 (0) 1628 556001
E: Eurtraining@zebra.com 

T: + 65 6858 0722
F: +65 6885 0838
E: China: tschina@zebra.com
All other areas:
tsasiapacific@zebra.com

Inquiry Department
For product literature and 
distributor and dealer 
information.

T: +1 877 ASK ZEBRA (275 9327)
E: inquiry4@zebra.com 

T: +44 (0) 1628 556037
F: +44 (0) 1628 556005
E: mseurope@zebra.com 

E: China: GCmarketing@zebra.com
All other areas:
APACChannelmarketing@zebra.com

Customer Service 
Department (US)
Internal Sales 
Department (UK)
For printers, parts, media, 
and ribbon, please call your 
distributor or contact us.

T: +1 877 ASK ZEBRA (275 9327)
E: clientcare@zebra.com 

T: +44 (0) 1628 556032
F: +44 (0) 1628 556001
E: cseurope@zebra.com 

T: +65 6858 0722 
F: +65 6885 0836 
E: China: order-csr@zebra.com
All other areas:
csasiapacific@zebra.com 

Key: T: Telephone
F: Facsimile
E: E-mail
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